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ADOBE PREMIERE PRO CC

Приложение Adobe Premiere Pro — это программа для нелинейного монтажа, которая позволяет вам 
помещать, заменять и перемещать отснятый видеоматериал в том порядке, который должен быть в 
конечном видеофайле. В любой момент времени вы можете внести изменения в какой угодно сегмент 
вашего видеоклипа. Больше не нужно выполнять монтаж в строго определенном порядке, вы можете 
изменить любую часть вашего видеопроекта, когда захотите.



1. Съемка видеоматериала. Этот этап может включать запись начального видеоматериала или сбор 
необходимых исходных файлов для проекта . 

2. Захват (передача или импорт) видеоматериала на жесткий диск. При работе с ленточными носителями 
видеоданных приложение Adobe Premiere Pro (при наличии соответствующего оборудования) может автоматически 
преобразовывать видеоматериал в файлы на вашем компьютере. При работе с безленточными носителями 
информации программа позволяет считывать видеоданные напрямую, без необходимости их конвертации. В этом 
случае обязательно создавайте резервную копию исходных данных 

3. Организация клипов. В наши дни проекты могут содержать огромное множество фрагментов 
видеоматериала. Потратьте необходимое время, чтобы организовать клипы, используемые в вашем проекте, при 
помощи специальных папок, называемых корзинами. Вы также можете добавить цветовые метки и метаданные 
(дополнительную информацию о клипах) для организации видеоматериала. 

4. Сборка фрагментов видео- и аудиоматериала в последовательность и добавление их на монтажный стол. 

СТАНДАРТНЫЙ 
РАБОЧИЙ ПРОЦЕСС 
ВИДЕОМОНТАЖА



СТАНДАРТНЫЙ 
РАБОЧИЙ ПРОЦЕСС 
ВИДЕОМОНТАЖА

5 Создание монтажных переходов между клипами, применение видеоэффектов и 
выполнение композитинга путем размещения клипов на нескольких слоях (дорожках).

6 Создание титров или изображений и добавление их в вашу последовательность. 
Используется та же методика, что и при работе с видеоклипами.

7 Микширование нескольких звуковых дорожек для получения приемлемого уровня 
громкости и применение монтажных переходов и специальных эффектов к аудиоклипам для 
улучшения качества звука.

8 Экспорт завершенных проектов на видеоленту, в файл на жесткий диск компьютера, в 
потоковый видеоролик для воспроизведения во Всемирной паутине, на мобильное 
устройство, на диски формата DVD или Blu-ray.



ИНТЕРФЕЙС ПРОГРАММЫ



• Панель Effects (Эффекты). Тут содержатся все эффекты, которые вы будет применять в 
своих последовательностях, включая видеофильтры, звуковые эффекты и переходы (эта 
панель по умолчанию состыкована с панелью Project (Панель)). Эффекты сгруппированы по 
типам для упрощения их поиска в процессе работы. 

• Панель Audio Clip Mixer (Микшер аудиоклипа). Интерфейс этой панели (по умолчанию 
состыкованной с панелями Source (Источник), Effect Controls (Управление эффектами) и 
Metadata (Метаданные)) очень похож на аппаратные средства звукозаписывающей студии 
своими регуляторами уровня громкости и ручками панорамирования: по одному набору 
элементов управления для каждой аудиодорожки на монтажном столе. Общие 
корректировки, внесенные вами, применяются к аудиоклипам в целом, в то время как 
изменения, произведенные на панели Audio Track Mixer (Микшер аудиодорожек), 
применяются к дорожкам. 

• Панель Effect Controls (Управление эффектами). Эта панель (по умолчанию 
состыкованная с панелями Source (Источник), Audio Clip Mixer (Микшер аудиоклипа) и Metadata 
(Метаданные), и доступная через меню Window (Окно)) содержит элементы управления 
любыми эффектами, примененными к выбранному клипу на монтажном столе. Для любого 
видеоклипа, фотоснимка или рисунка всегда доступно три видеоэффекта: Motion 
(Движение), Opacity (Непрозрачность) и Time Remapping (Перераспределение времени). 
Большинство параметров эффектов можно изменять с течением времени.

ИНТЕРФЕЙС 
ПРОГРАММЫ



ИНТЕРФЕЙС 
ПРОГРАММЫ

• Монтажный стол. Здесь производится основная часть всего монтажа — создание и работа с 
последовательностями (термин, используемый в продуктах Adobe для отдельных видеофрагментов 
или всего проекта). Главное свойство последовательностей заключается в том, что их можно 
вкладывать — помещать одни в другие. Таким образом объемный проект можно разделить на 
легкоуправляемые части.

• Дорожки. Можно наслаивать (то есть комбинировать) видеоклипы, изображения, графику и титры 
на неограниченном количестве дорожек. Видеоклипы перекрывают все остальные материалы, 
располагающиеся на дорожках, находящихся ниже на монтажном столе. Следовательно, клипам, 
располагающимся на первых по счету (верхних) дорожках, нужно задавать определенную степень 
прозрачности или уменьшать их размер, если вы хотите, чтобы через них были видны клипы, 
расположенные ниже. 

• Панели мониторов. Вы будете работать с монитором источника, располагающимся слева, чтобы 
просматривать и обрезать необработанный исходный видеоматериал. Чтобы просмотреть клип на 
мониторе источника , дважды щелкните мышью по файлу на панели Project (Проект). Монитор 
программы, расположенный справа, предназначен для просмотра монтируемой 
последовательности. Некоторые монтажеры предпочитают работать с одним монитором. В уроках 
описана работа с двумя мониторами. Но при желании вы можете использовать только один из них. 
Нажмите кнопку Close (Закрыть) возле имени вкладки монитора источника, чтобы закрыть его. 
Выберите команду меню Window ⇒ Source Monitor (Окно ⇒ Монитор источника), чтобы снова 
открыть этот монитор. 

• Панель Project (Проект). Здесь размещаются ссылки на файлы исходных материалов проекта: 
видеоклипы, звуковые файлы, графику, неподвижные изображения и последовательности. Для 
организации исходных материалов можно использовать специальные папки — корзины. 



• Панель Info (Информация). Панель Info (Информация) (по умолчанию 
состыкованная с панелью Project (Проект) и браузером материалов) 
отображает информацию о текущем состоянии любого объекта, 
выделенного на панели Project (Проект), или любого клипа или перехода, 
выделенного в последовательности. 

• Панель History (История). Эта панель (по умолчанию состыкованная с 
панелями Effects (Эффекты) и Info (Информация)) сохраняет выполненные 
действия и позволяет отменить все или некоторые из них, если 
получившийся результат вам не нравится. 

• Браузер материалов. Эта панель позволяет находить нужные файлы 
материалов в файловой системе компьютера. Данная возможность 
чрезвычайно полезна при работе с видеоматериалами, представленными в 
виде файлов.

ИНТЕРФЕЙС 
ПРОГРАММЫ



Давайте начнем работу с создания 
нового проекта.

1. Запустите приложение Adobe 
Premiere Pro. Появится экран 
приветствия. Список Recent Projects 
(Недавние проекты) будет содержать 
имена проектов, с которыми вы недавно 
работали. Если до настоящего момента 
вы не запускали программу Adobe 
Premiere Pro, он будет пуст.

ВЫБОР 
НАСТРОЕК 
ПРОЕКТА



На экране приветствия доступно несколько элементов управления:

• New Project (Новый проект). Открывает диалоговое окно New Project (Новый 
проект).

• Open Project (Открыть проект). Позволяет найти существующий файл 
проекта и открыть его, чтобы продолжить работу над этим проектом .

• Resources (Ресурсы). Открывает онлайн-версию справки. Для доступа к ней 
необходимо иметь подключение к Интернету.

• Exit (Выход). Завершает выполнение программы Adobe Premiere Pro.

• Sync Now/Sync Settings Now (Синхронизировать/Настроить 
синхронизацию): позволяет синхронизировать ваши пользовательские 
установки с сохраненными в облаке Creative Cloud.

• Use Settings from a Different Account (Использовать настройки другой 
учетной записи): позволяет выбрать учетную запись Adobe

• ID для синхронизации установок.

ВЫБОР 
НАСТРОЕК 
ПРОЕКТА



ВЫБОР НАСТРОЕК ПРОЕКТА

2. Выберите действие New Project (Новый проект), чтобы открыть одноименное диалоговое окно. 
Открывшееся диалоговое окно содержит две вкладки: General (Общие) и Scratch Disks (Рабочие диски). Все 
настройки, представленные в данном диалоговом окне, могут быть изменены позднее. В большинстве случаев 
будет достаточно использовать текущие настройки. Давайте познакомимся с ними поближе.



3. Щелкните по полю ввода Name: (Имя) и введите 
название для вашего нового проекта — (например, 
Lesson 02).

4. Нажмите кнопку Browse (Найти) и выберите 
желаемое местоположение для хранения файла 
проекта на жестком диске вашего компьютера.

ВЫБОР 
НАСТРОЕК 
ПРОЕКТА



Для импортирования материалов в программу 
Adobe Premiere Pro существует два принципиальных 
подхода:

• Стандартное импортирование с 
использованием команды меню File ⇒ Import (Файл 
⇒ Импортировать).

• Импортирование при помощи браузера 
материалов.

В использовании команды Import (Импортировать) 
нет ничего сложного. Чтобы импортировать файл, 
выберите команду меню File ⇒ Import (Файл ⇒ 
Импортировать). Вы также можете использовать 
сочетание клавиш Ctrl+I (Windows) или Command+I 
(OS X), чтобы открыть стандартное диалоговое окно 
Import (Импорт).

ИМПОРТ 
МУЛЬТИМЕДИЙНЫХ
МАТЕРИАЛОВ



ПАНЕЛЬ PROJECT

Любые ресурсы, которые вы импортируете в проект программы Adobe Premiere Pro CC, 
отображаются на панели Project (Проект). Если на панели Project (Проект) удалить клип, 
который уже используется в последовательности, данный клип будет автоматически удален из 
последовательности. 



Давайте познакомимся с элементами управления воспроизведением.

ОСНОВНЫЕ ЭЛЕМЕНТЫ УПРАВЛЕНИЯ 
ВОСПРОИЗВЕДЕНИЕМ

1. В нижней части панели монитора источника находится указатель текущей позиции воспроизведения 
желтого цвета. Перетаскивая его влево или вправо, вы можете просматривать различные фрагменты клипа. 
Также можно щелкнуть в любой позиции шкалы времени, чтобы переместить указатель непосредственно в 
эту точку.

2. Ниже полосы навигации по клипу и указателя текущей позиции воспроизведения находится полоса 
прокрутки, которая дублирует функциональность элемента управления Zoom (Масштаб). Перетащите любой 
конец полосы прокрутки, чтобы увеличить масштаб отображения клипа на полосе навигации.



3. Нажмите кнопку Play (Воспроизведение), чтобы проиграть клип. Снова 
щелкните по этой кнопке, чтобы остановить его. Также для начала и остановки 
воспроизведения можно использовать клавишу Пробел.

4. Кнопки Step back (Шаг назад) и Step forward (Шаг вперед) используются для 
перемещения по клипу на один кадр назад и вперед соответственно. Вы также 
можете использовать клавиши ← и → на клавиатуре.

5. Используйте клавиши J, K и L для воспроизведения клипа.

ОСНОВНЫЕ ЭЛЕМЕНТЫ 
УПРАВЛЕНИЯ 
ВОСПРОИЗВЕДЕНИЕМ



Монтажный стол используется для просмотра и монтажа последовательностей. Для большинства 
операций, выполняемых на монтажном столе, вы будете использовать обычный инструмент 
Selection-Выделение (клавиша V).

ЗНАКОМСТВО С 
МОНТАЖНЫМ 
СТОЛОМ



На рисунке представлены дорожки V1-V3 
(дорожка для клипов) и A1-A3 (дорожка для 
аудио) монтажного стола.

Клипы и аудио могут быть расположены на 
любой из дорожек, в зависимости от того, 
чего хочет создатель видеоролика. 
Программа позволяет добавлять до 99 
видео и аудиодорожек.

ЗНАКОМСТВО С 
МОНТАЖНЫМ 
СТОЛОМ

Индикаторы исходной дорожки позволяют 
включать или отключать видео- и звуковые 
каналы исходных клипов. Благодаря 
возможности перемещения индикаторов 
исходной дорожки и включения или 
отключения дорожек вы можете выполнять 
более сложный монтаж клипов.

Исходная дорожка V1 
выключена

Исходная дорожка V1 включена



ДОБАВЛЕНИЕ, 
ВЫДЕЛЕНИЕ, 
РАЗДЕЛЕНИЕ КЛИПОВ

После импорта в проект медиафайлов, переместите их на Временную ленту (Timeline).

Простейший способ выделить клип в последовательности — это щелкнуть по нему. Для создания выделений 
используется стандартный инструмент монтажного стола — инструмент Selection (Выделение) (клавиша V). 

Также часто бывает, что после добавления 
клипа в последовательность вы вдруг 
понимаете, что этот клип должен быть разбит 
на две части. Используйте инструмент Razor 
(Бритва), для быстрого выбора которого 
можно нажать клавишу C.



Переходы позволяют плавно соединить два видео- или аудиоклипа. 
Видеопереход часто используется при изменении времени и места действия. 
Аудиопереход позволяет избежать резких перепадов громкости, раздражающих 
слух.

Программа Adobe Premiere Pro предлагает специальные эффекты и анимацию, 
с помощью которых вы можете соединить клипы на монтажном столе. Такие 
переходы, как наплыв, вытеснение страницы, вращение экрана и т. д., 
позволяют легко перейти от одной сцены к другой. Большая часть работы над 
переходами происходит на панели Effect Controls (Управление эффектами).

Видеопереходы делятся на два вида. Наиболее используемые входят в группу 
Video Transitions (Видеопереходы), в которой они делятся по стилям на 6 
категорий. Дополнительные видеопереходы вы можете найти в группе Video 
Effects (Видеоэффекты), расположенной на панели Effects (Эффекты).

ДОБАВЛЕНИЕ
ВИДЕОПЕРЕХОД
ОВ



1.  Перетащите клипы на Временную ленту (Timeline).

2. На панели Effects (Эффекты) раскройте Video Transitions ⇒ Dissolve 

(Видеопереходы ⇒ Наплыв). Выберите эффект Cross Dissolve (Перекрестный 
наплыв). 

Для поиска нужного эффекта по названию вы можете использовать поле поиска 
в верхней части панели.

3. Перетащите эффект в начало первого клипа. Появится значок Start At Cut 
(Начало 

от склейки), показывающий, что это односторонний переход.

4. Перетащите эффект Cross Dissolve (Перекрестный наплыв) в конец 
последнего клипа. 

Значок End At Cut (Конец к склейке) ясно показывает, что эффект начнется до 

завершения клипа и закончится вместе с ним. В этом случае видно, что переход 

Cross Dissolve (Перекрестный наплыв) не увеличит длительность клипа.

5. Несколько раз воспроизведите последовательность, чтобы оценить результат 

применения перехода. 

ПРИМЕНЕНИЕ 
ОДНОСТОРОННЕГО 
ПЕРЕХОДА



Применение перехода к склейке двух клипов начинается с 
перетаскивания. Давайте попробуем создать анимацию между 
несколькими клипами. Продолжайте работу с предыдущей 
последовательностью.

СОЗДАНИЕ ПЕРЕХОДА МЕЖДУ ДВУМЯ 
КЛИПАМИ

1. Перетащите переход Dip to White 
(Погружение в белое) из категории 
Dissolve (Наплыв) на склейку первого и 
второго клипа.

2. Несколько раз воспроизведите 
последовательность, чтобы оценить 
результат применения перехода.



ДОБАВЛЕНИЕ 
АУДИОПЕРЕХОДОВ

1. Откройте Audio Transitions ⇒ Crossfade (Аудиопереходы ⇒ Наплыв), расположенную на 
панели Effects (Эффекты).

2. Перетащите переход Exponential Fade (Экспоненциальный наплыв) в начало первого 
аудиоклипа (на дорожку А1).

3. Измените длительность аудиоперехода в большую или меньшую сторону методом 
перетаскивания и прослушайте эффект, воспроизведя последовательность на монтажном 
столе.

4. Чтобы придать проекту лоск, добавьте видеопереход Cross Dissolve (Перекрестный 
наплыв) в начало и в конец последовательности. Для этого расположите указатель текущей 
позиции монтажа в начале последовательности и нажмите сочетание клавиш Ctrl+D (Windows) 
или Command+D (OS X).

5. Воспроизведите последовательность на монтажном столе и оцените изменения.



Каждый раз, когда вы добавляете клип на монтажный стол программы Adobe Premiere Pro, к нему автоматически 
применяется фиксированный эффект Motion (Движение). Чтобы управлять им, вы будете использовать панель 
Effect Controls (Управление эффектами). На этой панели доступны свойства эффекта Motion (Движение) 
(доступ к ним можно получить щелчком мышью по треугольнику рядом с названием эффекта). 

С помощью эффекта Motion (Движение) вы можете настроить положение, масштаб и угол поворота клипа. 
Программа предоставляет ряд возможностей по настройке кадров на экране. Давайте посмотрим, как данный 
эффект используется для изменения положения клипа.

НАСТРОЙКА 
ЭФФЕКТА MOTION

Несмотря на автоматическое применение эффекта Motion (Движение), 
анимация клипа не выполняется по умолчанию. Клип отображается в 
оригинальном размере в центре монитора программы. Однако вы можете 
настроить следующие параметры:
• Position (Положение). Этот параметр определяет положение клипа по 
осям Х и Y (на основании точки привязки). Координаты вычисляются на 
основании расстояния в пикселах относительно верхнего левого угла.
• Scale (Масштабирование). По умолчанию клипы имеют оригинальный 
размер (100%). Вы можете уменьшить изображение, введя значение 0, или 
увеличить его вплоть до 600%.



• Scale Width (Масштабирование по ширине). Для активации данного параметра следует сбросить флажок Uniform 
Scale (Масштабирование с сохранением пропорций). Сброс флажка позволит изменять высоту и ширину изображения 
клипа независимо друг от друга.

• Rotation (Вращение). Вы можете вращать изображение вдоль оси z (как при вращении грампластинки на 
проигрывателе или карусели, если смотреть сверху). Вы можете задать угол или число оборотов, например 450° или 
1×90. Положительное число указывает на вращение по часовой стрелке, отрицательное — против часовой стрелки. 
Можно задать до 90 вращений в любом направлении, то есть до 180 полных оборотов для изображения одного клипа.

• Anchor Point (Точка привязки). По умолчанию находится в центре клипа. Однако при необходимости ее можно 
изменить для определения центра вращения или масштабирования объекта. Вы можете заставить изображение клипа 
вращаться вокруг любой точки экрана, включая угол изображения клипа, или вокруг точки вне изображения клипа (как 
вращался бы, например, шар на конце веревки). Если вы переместите точку привязки, возможно, вам придется 
переместить и клип, чтобы компенсировать смещение.

• Anti-flicker Filter (Фильтр дрожания). Данная функция полезна, когда изображение содержит мелкие детали, 
например тонкие линии, резкие границы, параллельные линии (муаровый эффект) или вращение. Все эти детали 
способны вызывать дрожание изображения при анимации. Настройка по умолчанию (0.00) не добавляет размытия и не 
влияет на дрожание. Чтобы добавить немного размытия и устранить дрожание, используйте значение 1.00.

НАСТРОЙКА 
ЭФФЕКТА MOTION



Давайте более подробно рассмотрим анимированный клип.

1. Щелкните мышью по клипу на монтажном столе, чтобы 
убедиться, что он выделен.

2. В окне, в котором находится монитор источника, найдите 
вкладку Effect Controls (Управление эффектами) и щелкните по 
ней мышью.

3. Щелкните мышью по треугольнику Motion (Движение) на 
панели Effect Controls (Управление эффектами), чтобы 
отобразить параметры эффекта Motion (Движение).

НАСТРОЙКА 
ЭФФЕКТА MOTION



НАСТРОЙКА 
ЭФФЕКТА MOTION

4. Измените масштабирование и позицию клипа 
на разных отрезках времени на панели Effect 
Controls (Управление эффектами), изменив 
параметры, чтобы получилось как на 
изображении.

5. Нажмите кнопку Go To Previous Keyframe 
(Перейти к предыдущему ключевому 
кадру) или Go To Next Keyframe (Перейти 
к следующему ключевому кадру), 
чтобы переключиться между 
существующими ключевыми кадрами 
клипа.



Теперь, когда вы знаете, как воспроизвести 
анимацию, давайте вернем клип в исходное 
состояние.

6. Нажмите кнопку секундомера Toggle Animation 
(Переключатель анимации) слева от названия 
свойства Position (Положение), чтобы отключить 
ключевые кадры данного свойства.

НАСТРОЙКА 
ЭФФЕКТА MOTION

Фиксированный эффект Motion (Движение) 
добавляет выразительности всему клипу. Он 
может быть полезен при анимации изображения, 
изменении размера и положения видеоклипа в 
кадре. Вы также можете анимировать положение 
объекта с помощью ключевых кадров и 
улучшить анимацию, управляя их 
интерполяцией.



Видеоэффекты используются по многим причинам. Они могут 
помочь исправить проблемы, связанные с качеством 
изображения (например, с экспозицией и цветовым балансом). 
С их помощью можно создавать сложные, комбинированные 
визуальные эффекты, используя такие технологии, как 
композитинг и кеинг. Видеоэффекты применяются для решения 
различных производственных проблем, вроде дрожания 
камеры или эффекта «роллинг шаттер», а также в 
стилистических целях. С их помощью можно менять цветность, 
добавлять искажения в отснятый материал или анимировать 
изменение размера и положения клипа в кадре. Задача состоит 
в том, чтобы знать, когда использовать эффект, а когда — нет.

Добавить видеоэффект в программе Adobe Premiere Pro очень 
просто: вы можете перетащить его на клип вручную или 
выделить клип, а затем дважды щелкнуть мышью по названию 
эффекта на панели Effects (Эффекты).

ДОБАВЛЕНИЕ
ВИДЕОЭФФЕКТОВ



Поскольку в программе более 100 эффектов, они организованы в 
корзины, что упрощает процесс поиска. Вы найдете 16 стандартных 
корзин (категорий) (при использовании эффектов, созданных 
сторонними разработчиками, количество корзин может увеличиться). 
Корзины объединяют эффекты по логическим задачам, например, 
Distort (Искажение), Keying (Кеинг) и Time (Время). Это упрощает 
поиск и выбор нужного эффекта.

ДОБАВЛЕНИЕ ВИДЕОЭФФЕКТОВ

1. Выделите клип на монтажном столе.

2. Щелкните мышью по вкладке Effects (Эффекты), чтобы 
открыть одноименную панель. Также это можно сделать, 
нажав сочетание клавиш Shift+7.

3. Дважды щелкните мышью по корзине Video Effects 
(Видеоэффекты), чтобы открыть ее.

4. Введите слово black в поле поиска панели Effects 
(Эффекты), чтобы сузить результаты поиска. Выберите 
видеоэффект Black & White (Черно-белое).

5. Перетащите видеоэффект Black & White (Черно-белое) на 
ваш клип, расположенный на монтажном столе.



ДОБАВЛЕНИЕ 
ВИДЕОЭФФЕКТОВ

Применение этого эффекта мгновенно преобразует ваш полноцветный 
материал в черно-белый или, более точно, в оттенки серого. Кроме того, 
данный эффект появится на панели Effect Controls (Управление эффектами).

5. Убедитесь, что клип выделен на монтажном столе.

6. При необходимости, щелкните мышью по вкладке Effect Controls 
(Управление эффектами), чтобы открыть данную панель.

7. Включать и отключать действие эффекта можно с помощью кнопки fx, 
расположенной рядом с его названием на панели Effect Controls (Управление 
эффектами). Чтобы оценить эффект, убедитесь, что индикатор текущей 
позиции монтажа расположен на данном клипе.

8. Включение и выключение эффекта — это хороший способ увидеть, каким 
образом он сочетается с остальными. Для эффекта Black & White (Черное и 
белое) предусмотрен только параметр fx. Данный эффект может быть 
включен или выключен.



9. Убедитесь, что клип выделен, и параметры 
эффектов отображены на панели Effect Controls 
(Управление эффектами). Выделите эффект 
Black & White (Черно-белое) и нажмите клавишу 
Delete. 

ДОБАВЛЕНИЕ 
ВИДЕОЭФФЕКТО
В

10. Введите слово Direction в поле поиска панели 
Effects (Эффекты), чтобы сузить диапазон 
поиска. Найдите видеоэффект Directional Blur 
(Направленное размытие).

11. Дважды щелкните мышью 
по эффекту Directional Blur 
(Направленное размытие) 
на панели Effects (Эффекты), 
чтобы применить его.

12. На панели Effect Controls 
(Управление эффектами) 
щелкните по треугольнику 
слева от названия эффекта 
Directional Blur (Направленное 
размытие) и обратите 
внимание на появившиеся 
настройки, не 
предусмотренные для 
эффекта Black & White (Черно-
белое): Direction 
(Направление размытия), 
Blur Length (Длительность 
размытия), а также на значок 
секундомера рядом с каждой 
настройкой (он предназначен 
для активации ключевых 
кадров, о чем пойдет речь 
далее в этом уроке).



12. Присвойте параметру Direction (Направление) значение 90°, а параметру Blur Length (Длительность размытия) 
— значение 4, чтобы имитировать сцену, снятую с медленной скоростью затвора.

13. Щелкните мышью по треугольнику слева от названия настройки Blur Length (Длительность размытия) и 
переместите ползунковый регулятор, находящийся чуть ниже на панели Effect Controls (Управление эффектами). 
При изменении значения данного параметра результат мгновенно отображается на мониторе программы.

ДОБАВЛЕНИЕ
ВИДЕОЭФФЕКТОВ

14. Откройте меню в правом верхнем углу панели 
Effect Controls (Управление эффектами) и 
выберите команду Remove Effects (Удалить 
эффекты).
15. Откроется диалоговое окно с перечнем всех 
эффектов, которые можно удалить. Нажмите 
кнопку ОK, поскольку нам нужно удалить все 
эффекты. Это самый простой способ начать все с 
начала.



Экспорт проекта — это последний шаг в 
производстве видеопродукции.

ЭКСПОРТ ПРОЕКТА

1. Для экспорта проекта выделите 
последовательность (на панели Project 
(Проект) или на монтажном столе) и 
выберите команду меню File ⇒ Export ⇒ 
Media (Файл ⇒ Экспорт ⇒ 
Мультимедиа). Откроется диалоговое 
окно Export Settings (Настройки 
экспорта). Чуть позже мы рассмотрим 
интерфейс этого окна.2. Щелкните мышью по 

ссылке Output Name 
(Выходное имя), 
чтобы выбрать каталог 
для сохранения и 
ввести имя целевого 
файла.

3. Выберите целевую папку, а в 
качестве имени файла введите 
текст-название файла.
4. Нажмите кнопку Save 
(Сохранить).
5. Нажмите кнопку Export 
(Экспорт), чтобы создать 
цифровую копию 
последовательности.



ЭКСПОРТ ПРОЕКТА

При экспорте последовательности в качестве фильма 
вы можете изменить используемый кодек. Некоторые 
форматы видеозаписи (например, DSLR и HDV) сильно 
сжимают изображение. Использование более 
качественного кодека может улучшить качество 
созданного вами мастер-файла.

6. В раскрывающемся списке Video Codec 
(Видеокодек) выберите кодек, установленный на 
вашем компьютере (mp4, mov, MPEG и др.).


